COMPUTER ASSISTED MEDICAL DIAGNOSIS (CAMD)

SYSTEM VERSION 1.0

USER'S GUIDE

H. L. Ly
D. H. Ryman
D. M. Pearsall

Report No. 92-21

Approved for public release; distribution unlimited.

NAVAL HEALTH RESEARCH CENTER
P. O. BOX 85122
SAN DIEGO, CALIFORNIA 92186 – 5122

NAVAL MEDICAL RESEARCH AND DEVELOPMENT COMMAND
BETHESDA, MARYLAND
Computer Assisted Medical Diagnosis (CAMD) System
Version 1.0
Users' Guide

Prepared by:

Hoa L. Ly
David H. Ryman
Dianna M. Pearsall

Naval Health Research Center
Medical Decisions Support Department
P.O. Box 85122
San Diego, CA 92186-5122

Report No. TR 92-21 was supported by the Naval Medical Research and Development Command, Bethesda, MD, Department of the Navy, under Work Unit No. 63706N M0095.005-6103. The views expressed in this article are those of the authors and do not reflect the official policy or position of the Department of the Navy, Department of Defense, nor the U.S. Government.
SUMMARY

The CAMD system is designed to assist corpsmen in rendering a medical diagnosis. The CAMD system was written in FoxPro Version 2.0, a database management system. The signs, symptoms, and laboratory information collected by the Abdominal and Chest modules can be gathered on the standard forms developed for CAMD, or entered directly (real time) into the system. The Chronological Record of Medical Care (SF600) can then be generated to document an encounter. Additionally, information from the disease and treatment files can be added to the SF600.

The CAMD system User’s Guide was written to introduce the Independent Duty Corpsmen to this software system, explaining the Keyboard and Mouse commands necessary to run the various options, and displaying the screens associated with them.
Table of Contents

Section 1 Introduction ........................................ 1
  1.1 Purpose of the Computer Assisted Medical Diagnosis (CAMD) System
       Users' Guide ........................................ 1
  1.2 Computer Assisted Medical Diagnosis (CAMD) ........................ 1
  1.3 References ........................................ 1
  1.4 Terms and Abbreviations ................................ 2

Section 2 System Summary ...................................... 3
  2.1 System Application .................................. 3
  2.2 Programming Language ................................ 3
  2.3 Security/Privacy ................................... 3
  2.4 Flexibility ........................................ 3
  2.5 Maintenance ....................................... 3
  2.6 Error Messages. .................................... 3
    2.6.1 Too Many Files Open Error Message ................ 3
    2.6.2 Out of Environment Space Error Message ............ 3
  2.7 System Organization ................................ 4
  2.8 System Menu Options ................................ 5

Section 3 Accessing the System ................................ 6
  3.1 Entering CAMD (log-on) ................................ 6
  3.2 Exiting the CAMD (Log-off) ........................... 7
  3.3 Mouse Techniques .................................. 7
  3.4 Choosing A Menu .................................... 7
  3.5 Dialogs ........................................... 8
  3.6 On-Line Help (F1) .................................. 10
  3.7 Text editing ....................................... 11

Section 4 System Transactions ................................. 12
  4.1 System menu ........................................ 12
    4.1.1 Help <F1> ..................................... 12
    4.1.2 Change Password ............................... 12
    4.1.3 Backup ....................................... 13
    4.1.4 Restore ...................................... 13
    4.1.5 Calculator .................................... 14
    4.1.6 Calendar/Diary ............................... 15
  4.2 File Menu .......................................... 16
    4.2.1 Reindex ........................................ 16
    4.2.2 Quit ......................................... 16
4.3 Edit Menu .................................................. 16

4.4 Diagnosis .................................................. 18
  4.4.1 Register Patient .................................. 18
  4.4.2 Encounter ......................................... 21
  4.4.3 Disease/Treatment Lookup .................. 26
  4.4.4 SF600 Report .................................. 27
  4.4.5 Encounter Training Mode .................. 29

Appendix A: Encounter Forms .................................................. 30
Appendix B: Text Editor Commands ............................................. 33
Appendix C: Diary/Calendar Commands ........................................ 38
Appendix D: Installation Guide .................................................... 41
Section 1 Introduction

1.1 Purpose of the Computer Assisted Medical Diagnosis (CAMD) System Users' Guide. The objective of the users' guide is to provide personnel, who may be unfamiliar with personal computer software, the information necessary to effectively use the CAMD system. Additionally, this guide will supply the users with a detailed description, as well as, the basic structure and features of the CAMD system.

1.2 Computer Assisted Medical Diagnosis (CAMD). Medical care on board many small ships and submarines is rendered by specially trained independent duty corpsmen. These vessels often operate in remote areas where these corpsmen cannot easily obtain consultations. Therefore, the Navy Medical Research and Development Command (NMRDC) initiated a program to develop a set of diagnostic algorithms that could be automated. The objectives of this effort are:

a) Provide medical practitioners with accurate medical diagnostic and treatment information.

b) Prevent unnecessary, hazardous, and disruptive medical evacuations by providing diagnostic assistance to independent duty corpsmen.

c) Improve communications between isolated independent duty corpsmen and their supporting medical officers by providing a standardized method for information collection.

d) Gather clinical information in a modifiable diagnostic knowledge base to ensure diagnostic accuracy.

1.3 References. The following references provide technical and background information for CAMD.


1.4 Terms and Abbreviations.

**Carriage Return < CR >.** Notation used to denote a carriage return typically executed by pressing the "ENTER" or "RETURN" key on a computer keyboard. If a mouse is available on the computer system, "click" or press the top left button for a return.

**Database Management (DBM).** A management approach to database design consisting of what information is collected, where information stored, and how it is processed by computer software.

**Default.** A response assumed by CAMD. If the default value is correct, the user need only press the "ENTER" or "RETURN" key.

**Expert System.** A computer program which emulates the behavior of a human expert in a specific area of knowledge.

**FoxPro.** A database management development system written by the Fox Software, Inc. FoxPro Version 2.0 was used to develop the CAMD system.

**SAMS.** SNAP Automated Medical System Version 7.0 is a FoxPro software application for handling shipboard medical department forms, files and data.

**SNAPS.** Shipboard Non-tactical ADP Program.

**System.** The combination of hardware, firmware, and software designed to function as an integrated unit.

**SF600.** The Chronological Record of Medical Care standardized form used for documenting a medical encounter.
Section 2 System Summary

2.1 System Application. On U.S. Navy submarines and small surface ships medical services are provided by independent duty corpsmen. To assist the corpsman and enhance their diagnostic skills, the U.S. Navy has initiated the development of CAMD system.

2.2 Programming Language. The CAMD software was written in the FoxPro Version 2.0 programming language. FoxPro is a database management software system created for the personal computer to produce computer applications.

2.3 Security/Privacy. The security module will maintain user passwords which allow log-on access to the program and database files. Menu options are assigned to the user through a security key system in FoxPro. CAMD collects and stores data covered under the 1974 Privacy Act.

2.4 Flexibility. Since CAMD was created by using the FoxPro utilities, enhancements and updates to the system can be accomplished with minimal programming. CAMD was design to compatible with SAMS.

2.5 Maintenance. The primary maintenance functions consist of security options, file and format definitions, user file updates, knowledge base editing, and initialization of data.

2.6 Error Messages. When installing the system the two major error messages that may occur are "Too many files open" and "Out of Environment Space."

2.6.1 Too Many Files Open Error Message. If the "Too many files open" message occurs, the following window will open. Select the <Cancel> button to end the program. Return to the root directory (cd c: \) and modify the CONFIG.SYS by adding or editing the FILES command to minimum 50. Example: FILES = 75. If the system does not have an editor then see EDLIN command in the MS-DOS manual.

2.6.2 Out of Environment Space Error Message. If an "Out of Environment Space" occurs, change the CONFIG.SYS file. Return to the root directory (cd C: \) and modify the CONFIG.SYS by adding the SHELL command.
The Shell command should appear as follows:

\[
\text{SHELL} = \text{COMMAND.COM} \ /P \ /E:512 \ (\text{DOS Version 3.2 and above})
\]

\[
\text{SHELL} = \text{COMMAND.COM} \ /P \ /E:32 \ (\text{DOS Version 3.1 and below})
\]

The "/P" will make it permanent and the "E/:(size)" will expand the environment space from the default of 160 bytes. Reboot the system after changing the CONFIG.SYS.

2.7 System Organization. The system has five main menus which are (1) System, (2) File, (3) Edit, (4) Diagnosis, and (5) Window. Accessing the system requires a password, see Section 3. Once the password is successfully entered, the following screens will appear:

![CAMD main menu](image)

The Computer Assisted Medical Diagnosis (CAMD) system contains disease description and treatment recommendations, as well as diagnostic assistance for two areas; Abdominal Pain and Chest Pain. Only the most common diseases in each category are considered for medical diagnosis. The Non-Specific disease in each area represents non-surgical, non-life threatening cases, which in general do not require evacuation.

YOUR JUDGEMENT MUST TAKE PRECEDENCE, the CAMD system cannot make the subjective evaluations which are often so important in medical diagnosis.

When using the CAMD system the lines at the bottom of the screen will indicate which keys to select. The <F1> key will give additional help and when available, display explanations or definitions of items or terms.

Press any key to continue...

![CAMD brief greeting screen](image)
2.8 **System Menu Options.** The following figure shows all options of the CAMD system. The system is operated using either a mouse or the keyboard to select the menu options described in Section 3.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help... F1</td>
<td>Reindex</td>
<td>Undo</td>
<td>Register Patient</td>
<td>Cycle</td>
</tr>
<tr>
<td></td>
<td>Quit</td>
<td>Redo</td>
<td>Encounter</td>
<td>Color...</td>
</tr>
<tr>
<td>Change Password</td>
<td>Cut</td>
<td>Copy</td>
<td>Disease/Treatment</td>
<td>SF600 Report</td>
</tr>
<tr>
<td>Backup</td>
<td>Paste</td>
<td>Paste</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Restore</td>
<td></td>
<td>Clear</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculator</td>
<td>Select All</td>
<td></td>
<td>Encounter Training</td>
<td></td>
</tr>
<tr>
<td>Calendar/Diary</td>
<td>Goto Line...</td>
<td></td>
<td>Mode</td>
<td></td>
</tr>
</tbody>
</table>

CAMD System Menu Options
Section 3 Accessing the System

3.1 Entering CAMD (log-on). Change the current directory to CAMD or the one in which CAMD was installed on the system (C:\CAMD). At the MS-DOS prompt, type CAMD and the following security prompt will be displayed.

Unauthorized access to this United States Government Computer System and/or software is prohibited by title 18, United States code, section 1030. This system may only be used for unclassified official business.

Enter Password: -

CAMD System Log-On Screen

Type in the password and <CR>. After an acceptable password has been entered a brief greeting will be shown.

(C) Naval Health Research Center, San Diego, Ca.

If problems occur please contact:
Ms. D. M. Pearsall (Dee)
Naval Health Research Center
P.O. Box 85122
San Diego, Ca. 92186-85122
DSN 553-8401 or Com (619) 553-8401

Computer Assisted Medical Diagnosis • 6
3.2 Exiting the CAMD (Log-off). Choose Quit from the File Menu options to exit the CAMD system. If any windows are left open, the system will ask if the user wants them closed. Select the <Yes> option.

3.3 Mouse Techniques

Point - Position the pointer at the specific location on the screen. When moving the mouse, the pointer moves in a similar manner.

Click - Point to an object then press and release the mouse button once.

Double click - Point to an object then press and release the mouse button twice in rapid succession.

Drag - Hold the mouse button down, roll the mouse until the pointer is in the desired location and release the mouse button.

3.4 Choosing A Menu

Keyboard:

1. Press the Alt key to select the first menu pad, then press the Right or Left Arrow keys to select other menu pads on the menu bar. Or Press the Alt key in conjunction with the highlighted letter of the menu pad.

2. Press <CR> to display the menu popup window.
3. Press the Up or Down Arrow keys to select an option then press <CR> to choose the option or enter the highlighted letter of the option and press <CR>.

Mouse:

1. Point to the menu pad and press the left mouse button to display the menu popup window.

2. Point to the desired option and press the left mouse button.

Menu Pad

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Popup</td>
<td>Reindex</td>
<td>Menu Option</td>
<td>Quit</td>
<td></td>
</tr>
</tbody>
</table>

Menu Bar

3.5 Dialogs. Dialogs are special boxes for the data entry that allow the user to choose the action about to take place.

Backup CAMD database: Scrolling List

[...] [DOC] CAMD9202.ZIP

Drive C

Directory CAMD

Default push button

Open push button

Backup Filename: Enter text box
Scrolling a list

Keyboard:

1. TAB to the list.
2. Press the Down Arrow key or UP Arrow Key

Mouse:

1. Click on the up or down arrow on the scroll bar.
2. Holding down the mouse button will cause the scrolling to continue until released.

Choosing an Option on a Popup

Keyboard:

1. Tab to the popup control, then press <CR> to display the popup.
2. Press the Up or Down Arrow keys to select the option then press <CR>.

Mouse:

1. Point to the popup control and press the mouse button to display the popup.
2. Drag to the desired option, then release the mouse button.

Choosing a Check Box, Radio Button, or Push Button

Keyboard:

1. TAB to the check box, radio button, or push button.
2. Press <CR>.

Mouse:

1. Point to the check box, radio button, or push button.
2. Press the button (click).
3.6 **On-Line Help (F1).** With the CAMD system, help is always close at hand with the F1 key. CAMD provides context sensitive help that can be accessed by pressing F1 or selecting the *Help* option on the *System Menu*. Questions concerning windows or dialogs can be answered by pressing the `<F1>` key.

![CAMD Help Topics Level Window](image)

**CAMD Help Topics Level Window**

![CAMD Help Detail Level](image)

**CAMD Help Detail Level**

---

*Computer Assisted Medical Diagnosis*  
*10*
To see help details for a topic, select the <<Topic>> and press <CR> or double-click on the topic the window or Spacebar. For more information on a topic, use the scroll bar.

To return to the topics level of the Help window and select another topic, choose <Topics>. To see information about the next topic, choose <Next>. To see information about the previous topic, choose <Previous>. The <Look Up> and See Also functions are not used by the CAMD system.

To close the HELP window using the keyboard press the escape key <ESC>. To close using the mouse point to the small white rectangle in the top left corner of the window and click.

3.7 Text editing. A text editor allows the user to type and modify information displayed in a region of the screen (e.g., Treatment or SF600 Report). When text editing, use the cursor to move through the text. The cursor looks like a flashing underscore, when in the insert mode, and a flashing box when in the overwrite mode. Press the <Insert> key to switch between modes. It is easy to move the cursor through text using eight basic keys. Four of these keys can also be used in combination with a modifier key <Ctrl> to move the cursor a greater distance. See Appendix B for The Table of Text Editor Commands.
Section 4  System Transactions. To access the top level menu options using the mouse, point to the option and click. To use the keyboard press down the <ALT> key and the first letter of the option. Example: < ALT > D to reach the Diagnosis Menu.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
</table>

4.1  System menu. System Menu options are used for file maintenance and desk accessories.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help...F1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Password</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculator</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calendar/Diary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4.1.1  Help <F1>. The Help option displays the Help Window described in Section 3.6.

4.1.2  Change Password. This options let the users change the password. When Change Password is chosen from the System Menu, type a new password and press <CR>. Remember this change is permanent, so memorize the new password or make a notation and place it somewhere safe.

Enter Password: __________________________
4.1.3 Backup. Backup is used to copy the database to another file. In the example the file was named CAMD9203. The 9203 represents the year and month in which the files were backed-up. To backup the files select the disk drive and directory where the file is to be stored, enter a name for the backup file, and select "<Open>". The system will automatically begin this process and display a message when finished.

![Backup CAMD database](image)

4.1.4 Restore. This option allows the user to restore or reinstall the database previously backed up by the CAMD system. To restore a backup file enter the disk drive and directory where the backup file was stored, enter the name of the file, and select "<Open>". The system will automatically begin this process and display a message when finished.

![Restore CAMD database](image)
4.1.5 Calculator. When the user chooses the *Calculator* option from the *System Menu* popup a graphic of a calculator appears on the screen. This Calculator used like a standard pocket calculator. Calculations can be performed either using the keyboard or the mouse.

To perform the calculation with the mouse, simply click on the appropriate numbers and symbols on the calculator.

With the keyboard, type the equation as it would be written. Most Calculator keys have the same keyboard equivalents, with the following exceptions:

<table>
<thead>
<tr>
<th>Key</th>
<th>Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q</td>
<td>√</td>
</tr>
<tr>
<td>R</td>
<td>MR</td>
</tr>
<tr>
<td>N</td>
<td>±</td>
</tr>
<tr>
<td>A</td>
<td>M+</td>
</tr>
<tr>
<td>Z</td>
<td>MC</td>
</tr>
<tr>
<td>S</td>
<td>M-</td>
</tr>
</tbody>
</table>

Calculator
4.1.6 Calendar/Diary. When the user chooses the Calendar/Diary option from the System Menu popup, a monthly calendar appears with the current day selected. This calendar is used just like any other calendar to check dates and keep track of appointments. The first time the this option is used the current day is select as a default. If the user wants a different day, the Calendar Window must first be closed, and then reopened. The default then becomes the last day selected. To close this menu option, press the <ESC> key or click the close box option.

To the right of the Calendar panel is the Diary panel. Use the Diary panel to input text associated with any date on the calendar panel. To activate the Diary panel, press the TAB key or choose Diary from Diary Menu Popup. To activate the Calendar panel, press shift+Tab or choose Calendar from the Diary Menu popup. Refer to Appendix C for more information.
4.2 File Menu. The File Menu contains options for manipulating data files. Currently there are only two options on this menu Reindex and Quit.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reindex</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4.2.1 Reindex. This option is used to reindex or sort the database files. When the user chooses the Reindex option from File Menu popup, a brief message will be displayed. The window will disappear when the task is completed.

4.2.2 Quit. The Quit option ends current CAMD session. When chosen, a message will be shown on the screen, and will return to the MS-DOS prompt (C:\CAMD).

4.3 Edit Menu. The Edit Menu options are used when editing the Treatment Section of the Encounter, and SF600.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select All</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Goto Line...</td>
<td></td>
</tr>
</tbody>
</table>

4.3.1 Undo. Reverses the last action that was performed while text editing. Selecting the Undo option repeatedly will reverse all entries made during the current editing session.
4.3.2 *Redo.* This is the opposite of *Undo.* Choose *Redo* to restore the text to its previous condition. Selecting this option will reverse the *Undo* option.

4.3.3 *Cut.* Removes selected text from any field, record, or text editing field.

4.3.4 *Copy.* Duplicates the selected text (without removing it) and places the copy on the clipboard.

4.3.5 *Paste.* Inserts a copy of the clipboard contents into the current file, field, text editing window at the cursor location. It will replace the contents of the clipboard with the selected text.

4.3.6 *Clear.* Clear permanently removes selected text or data without placing it on the clipboard. If the user chooses this option when text is selected, the result is the same as pressing the <Delete> or <Backspace> keys. Additionally, the *Clear* option is used to erase a window or the desktop.

4.3.7 *Select All.* All lines of text in the current editing window are selected.

4.3.8 *Goto Line.*... Displays the Goto Line dialog to move the cursor to a designated line in a text window.

![Goto Line Dialog](image)

In the Line Number text box, type the number of the line the cursor is to appear. When this option is chosen, the cursor moves to the beginning of the specified line, and the text of that line is displayed in the window. If the line number specified is greater than the number of lines in the window, the cursor is positioned on the last line.
4.4 Diagnosis. Currently, CAMD has two medical areas; Abdominal Pain and Chest Pain. Each area has its own medical diagnosis, disease, and treatment databases. The diagnosis data is grouped by disease categories, where only the most common diseases are considered. The Diagnosis Menu is the main menu for the CAMD system. Use the \(<\text{Tab}>\) \(<\text{CR}>\) keys to select options on the keyboard. Below are the five major functions:

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Register Patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Encounter</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SF600 Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Disease/Treatment Lookup</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Encounter Training Mode</td>
<td></td>
</tr>
</tbody>
</table>

4.4.1 Register Patient. This option allows the user to select, edit, search the SAMS data files, register a patient, and review existing patient records.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Register Patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Encounter</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SF600 Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Disease/Treatment Lookup</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Encounter Training Mode</td>
<td></td>
</tr>
</tbody>
</table>

PATIENT SELECTION

Social Security: - -

Last Name: ______________________

First Name: ______________________

\(<\text{OK}>\) \(<\text{Browse}>\) \(<\text{Cancel}>\)

This window allows the user to 1) Browse the entire database looking for a patient, 2) enter partial information about the patient, 3) select a patient from a candidate list, 4) add a new patient, or 5) cancel the selection process.
4.4.1.1 Browse. To lookup a patient with <Browse> using the keyboard press the <Tab> key until the cursor is located on top of the button, then press <CR>.

```
PATIENT SELECTION
Social Security:    
Last Name:          
First Name:         
< OK > < BROWSE > < CANCEL >
```

To select a patient move the cursor to the correct patient (arrow keys on the keyboard). If the information is 1) correct choose the <Select> button on the window, 2) incorrect select the <Edit> button, and 3) not found press the <Cancel> button.

```
PATIENT FILE

[0000022222] ANYBODY, ALMOST
[1111111111] DOE, JOHN
[2222222222] ARNOLD, ROSANNE
[3333333333] ZEE, ZORRO

< Select > < Edit > < Cancel >
```

4.4.1.2 OK. This option allows the user to enter partial numbers or names for look-up purposes. Enter information to distinguish one patient from another. The "?" can be used as a wild card character.

```
PATIENT SELECTION
Social Security:  2222
Last Name:        
First Name:       
< OK > < BROWSE > < CANCEL >
```
With the above entry the last four digits of a social security number could yield the following example:

![Select from the following candidates:]

| 0000022222 | ANYBODY, ALMOST |
| 2222222222 | ARNOLD, ROSANNE |

Here the user has several options:
1) Place the cursor on the patient in the list and press <Select>,
2) Place the cursor on the patient and <Edit> the patient information,
3) Add a new patient, if the person was not found, <New>,
4) <Search> through the SAMS database for the person,
5) <Cancel> and abort the process.

4.4.1.3 Patient Enter/Edit. This option is called from the previous window when the user selects <New>, <Edit>, <Search>, or the patient cannot be found. After the data is entered the user either selects <OK> to save the record or <CANCEL> to abort the process.

<table>
<thead>
<tr>
<th>Patient Enter/Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Security: 000 - 00 - 2222</td>
</tr>
<tr>
<td>Last Name:</td>
</tr>
<tr>
<td>First Name:</td>
</tr>
<tr>
<td>Middle Initial:</td>
</tr>
<tr>
<td>Date of Birth:</td>
</tr>
<tr>
<td>Sex:</td>
</tr>
<tr>
<td>Rate/Rank:</td>
</tr>
<tr>
<td>&lt;OK&gt;</td>
</tr>
</tbody>
</table>

4.4.1.4 CANCEL. To cancel the Register Patient option, select the <CANCEL> option and the menu window will close.
4.4.2 Encounter.. When the Encounter option is selected from the Diagnosis Menu, the patient seek function will be executed (see Section 4.4.1 above). If there is a pending encounter on the current patient, the system will prompt to <Resume> the current encounter, create a <New> encounter for the same complaint, or to <Cancel> this session.

System File Edit Diagnosis Window

Pending Encounters

Patient 123456789
Date 09/28/92
10:02:32 Acute abdominal pain

<Resume>  < New >  < Cancel >
Press the F1 key for help

After a selection has been made the following screen will appear:

System File Edit Diagnosis Window

Patient Encounter

Date 09/28/92  Time 10:02  Status P  Provider 1
Patient Name DOE  First JOHN
SSN 123-45-6789  Sex M  Age 45

<Symptom>  <Assist>
AGE

<Treatment>
< OK >  < Cancel >

<Print>  << Save >>  < Cancel >

Data contained herein are subject to the privacy act of 1974.
Afford protection in accordance with SECNAVINST 5211.5C
For a new encounter, the first button to be selected is <Complaint>. When the complaint button is activated the following window will pop-up:

Once the complaint has been entered, the symptom information can be added. Notice that the first information in the symptom window is age. If this was a pending encounter, the some of the symptom information may have already been entered.

Data contained herein are subject to the privacy act of 1974. Afford protection in accordance with SECNAVINST 5211.5C
Select the <Symptom> button to continue entering information. When this button is selected the question window will open. After answering the question, either select <OK> to accept the answer or <Cancel>. Cancel will stop the question and answer session.

When all of the questions are answered, the <Diagnosis> button should be selected. This button allows the user several options <Select> the marked diagnosis, <View> a description of the marked diagnosis, or <Cancel>. This button can be used when adding treatment information into the encounter form using the Edit Menu.
Once the diagnosis is entered, select the <Assist> button for the computer to compute a diagnosis. When this button is selected a calculating sign will appear.

The most likely diagnosis will appear first in the window, and any others will follow beneath. The next step would be to enter <Treatment>, <Print> the encounter, <Save> it to file, or <Cancel> to exit. The treatment field is a word processing field and is edited using the Edit Menu.

Data contained herein are subject to the privacy act of 1974. Afford protection in accordance with SECNAVINST 5211.5C
To print the patient encounter select the <Print> button on the Patient Encounter form. The user has an option of printing the information to a file or printer.

Print Encounter Report Function:

Save an encounter to another file

1) Select (x) File
2) Type in a name after Filename:
3) Select <OK>

Print an encounter:

1) Select (x) Printer
2) Select <OK> (make sure the printer is turned on before choosing <OK>.

Data contained herein are subject are subject to the privacy act of 1974. Afford protection in accordance with SECNAVINST 5211.5C
4.4.3 Disease/Treatment Lookup. This option allows the user to lookup the disease description and treatment protocol. The Disease/Treatment description contains seven sections: Disease Description, Discussion, Differential Diagnosis, Treatment of Disease, Usual Course with Treatment, Complications and Their Management, and Complications and Their Management.

When the Disease/Treatment Lookup option is selected from the Diagnosis Menu the following pop-up list of descriptions or treatment information will appear.

<table>
<thead>
<tr>
<th>DISEASE/TREATMENT REFERENCES</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACUTE PANCREATITIS</td>
</tr>
<tr>
<td>ANGINA</td>
</tr>
<tr>
<td>APPENDICITIS</td>
</tr>
<tr>
<td>CHEST INFECTION</td>
</tr>
<tr>
<td>CHOLECYSTITIS</td>
</tr>
<tr>
<td>DIVERTICULITIS</td>
</tr>
<tr>
<td>GASTRITIS</td>
</tr>
<tr>
<td>GASTROENTERITIS</td>
</tr>
<tr>
<td>HEPATITIS</td>
</tr>
<tr>
<td>INGUINAL HERNIA</td>
</tr>
<tr>
<td>MESENTERIC ADENITIS</td>
</tr>
<tr>
<td>MYOCARDIAL INFARCTION</td>
</tr>
<tr>
<td>NON-SPECIFIC ABDOMINAL PAIN</td>
</tr>
</tbody>
</table>

<Select>   <View>   <Quit>

Disease/Treatment References

To end this process select < Quit > or view any particular Disease or Treatment description simply selected the disease on the scrolling window, then select the < View > push button (see Section 3.5).
The following window of disease descriptions will appear. Select <OK> when finished.

### Disease Description

**Appendicitis (APPEND) Acute appendicitis**

Acute appendicitis results from a bacterial invasion of the appendix with inflammation. Incidence is highest in adolescents and young adults, peaking between ages 15 and 24. Typically the pain is initially poorly localized in the periumbilical region. This pain represents irritation of the lumen of the appendix itself. Gradually the pain shifts to the right lower quadrant, becoming constant and discrete as the inflamed appendix begins to irritate the surrounding peritoneum. Anorexia, fever and diminished bowel sounds are usually noted; nausea, vomiting and diarrhea are variable. Temperature, pulse and respiratory rate may be only slightly elevated unless perforation occurs.

< OK >

---

**4.4.4 SF600 Report.** This option extracts the encounter data and compiles it into the SF600 report format. The report can either be sent to a printer or stored in a file. The editor allows this report to be modified. See Appendix B for The Table of Text Editor Commands. When selecting the *SF600 Report* from *Diagnosis Menu* popup, the following window appears:

### Encounter to Report

Social Security:  -  -  
Lastname:  
Firstname:  
Encounter Date:  /  /  

« OK » < BROWSE > < CANCEL >
This option allows the user to fill in Social Security, Last name, First name or encounter date. If any field is unknown leave it blank. The input process allows partial information to be entered, use '?' as a single unknown character. To look up the existing patient encounter in the system, at least one field must be entered. Select <OK> when done, <Browse> to see the entire patient encounter listing, and <Cancel> to abort the process.

Patient in File

[0000000001] Example One

< Select > < Cancel >

Patient Selection

After the correct patient is selected, the system will search the encounter for a specified date. Select <OK> to continue or <Cancel> to quit.

Patient: 0000000001  
Date: 9/29/92

0000000001 14:44:38 Acute Abdominal Pain

< OK > <CANCEL>
The report editing appears when it is finished the generate report.

Report Editing

This 26 Years old male presents with pain over his whole chest which radiates to the left arm. The pain began about 2 days to a week ago and was gradual in onset. The patient has been in continuous pain. He describes the pain as sharp. Numbness is absent. The pain is moderate in severity and seems to be getting worse since it began. By history, coughing makes the pain worse and Pentaphenabarbitol and Gin seems to make the pain better. The patient reports dyspnea associated only this illness. The patient has no cough. Sputum is absent. Orthopnea is absent. Paroxysmal nocturnal dyspnea is absent. Reflux

< Print > < Save > < Cancel >

The users should read the form carefully and necessary changes. Press <Save> to save the change, <print> to output the report, <Cancel> to quit out the option.

The output device can be either a file or printer. Use arrow key or the mouse to select the device. If choosing a <File>, remember to enter the filename at the filename field. Select <OK> when ready send report to output device, or <Cancel> to stop the output report.

4.4.5 Encounter Training Mode. When this option is selected, information is stored in a temporary files and not into the permanent data base. See Section 4.4.3 for detail.
Appendix A: Encounter Forms
## ABDOMINAL PAIN DATA SHEET

**SITE OF PAIN AT ONSET**
- RUQ
- LUQ
- RLQ
- LLQ
- Upper Half
- Lower Half
- Right Half
- Left Half
- Central
- General
- Right Flank
- Left Flank
- No Pain

**SITE OF PAIN AT PRESENT**
- RUQ
- LUQ
- RLQ
- LLQ
- Upper Half
- Lower Half
- Right Half
- Left Half
- Central
- General
- Right Flank
- Left Flank
- No Pain

**OTHER SYMPTOMS:**
- **NAUSEA:**
  - Yes
  - No
- **APPETITE:**
  - Decreased
  - Normal
- **VOMITING:**
  - Yes
  - No
- **JAUNDICE**
  - (Hx or yellow skin / sclera)
    - Yes
    - No
- **BOWELS:**
  - Normal
  - Constipated
  - Diarrhea
  - Blood in Stool
  - Painful
  - Darker Urine
  - Mucus in Stool
  - Blood in Urine

**DATE/TIME:**

**AGE:**

**SEX:**

**TYPE OF PAIN:**
(free of pain at times = intermittent, constant = steady, constant but varying in intensity = colicky)
- Intermittent
- Steady
- Colicky

**SEVERITY OF PAIN:**
(if in obvious distress = severe, everything else = moderate)
- Moderate
- Severe

**PROGRESS OF PAIN:**
(at time of examination)
- Better
- Same
- Worse

**DURATION OF PAIN:**
(How long has the pt had the pain?)
- days

**PAST HISTORY**

**PREVIOUS INDIGESTION:**
- Yes
- No

**PREVIOUS SIMILAR PAIN:**
- Yes
- No

**PREVIOUS SURGERY:**
(intraperitoneal abdominal surgery or trauma)
- Yes
- No

**PREVIOUS ILLNESS:**
(any illness requiring hospitalization)
- Yes
- No

**TAKING MEDICATIONS:**
- Yes
- No

**AGGRAVATING FACTORS:**
(have patient move, cough)
- Movement
- Cough
- Food
- Breathing

**RELIEVING FACTORS:**
(lying still, vomiting, antacids, food, other, none)
- Lying Still
- Vomiting
- Antacids
- Food
- Other
- None

---

**Note:**
- SSN: [Field for Social Security Number]
- 31-A
<table>
<thead>
<tr>
<th>VITAL SIGNS</th>
<th>GENERAL/LAB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature:</td>
<td>Blood Pressure:</td>
</tr>
<tr>
<td>Systolic:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Respiration:</td>
<td>Diastolic:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**SITE OF TENDERNESS**
(area of significant pain, palpate most painful last)
- RUQ
- LUQ
- RLQ
- LLQ
- Upper Half
- Lower Half
- Right Half
- Left Half
- Central
- General
- Right Flank
- Left Flank
- No Pain

**ABDOMINAL EXAM**

**INSPECTION:**
(wavelike movement = visible peristalsis, pt. unable to touch hand with belly button = decreased/absent)
- Normal
- Visible Peristalsis
- Decreased Abd. Movement

**ABDOMINAL SCARS:**
- Yes
- No

**GUARDING:**
(voluntary tightening of abd. muscles, pt. can relax with gentle persuasion)
- Yes
- No

**BOWEL SOUNDS:**
(normal unless markedly hyperactive or absent)
- Normal
- Absent
- Hyperactive

**DISTENSION:**
(generalized swelling or bloating of entire abdomen)
- Yes
- No

**MASSES:**
(localized abdominal swelling)
- Yes
- No

**REBOUND TENDERNESS**
(do late in exam, slowly depress tender area, when pt. relaxed quickly release, grimace = rebnd. tenderness.)
- Yes
- No

**RECTAL EXAM**
(distinguish between pain and discomfort)
- Normal
- Mass Felt
- L.Tender
- R. Tender
- General Tenderness

**RIGIDITY:**
(involuntary tightening of abd. muscles, pt. cannot relax with gentle persuasion)
- Yes
- No

**PHYSICAL EXAM**

**CORPSMAN'S DIAGNOSIS:**
- Appendicitis
- Nonspecif Abd Pain
- Renal Colic
- Perf. Duod Ulcer
- Cholecystitis
- Small Bowel Obs.
- Other:

**MEDICAL OFFICER'S DIAGNOSIS:**
- Appendicitis
- Nonspecif Abd Pain
- Renal Colic
- Perf. Duod Ulcer
- Cholecystitis
- Small Bowel Obs.
- Other:

**MEDEVAC:**
- Yes
- No
# CHEST PAIN DATA SHEET

## SSN:

### SITE OF PAIN
- Central
- Chest
- L. Side
- R. Side
- Epigastic
- Other

### PAIN RADIATION
- Yes
- None
- L Arm
- R Arm
- Both Arms
- Back
- Shoulders
- Neck
- Jaw
- Throat
- Fingers/Hands
- Epigastic
- Other

## DATE/TIME:

### AGE:

### SEX:

## OTHER SYMPTOMS:

### DYSPNEA:
- Absent
- This Illness
- Chronic

### ORTHOPNEA:
- Yes
- No

### COUGH:
- Absent
- This Illness
- Chronic

### PND:
- Yes
- No

### SPUTUM:
- Yes
- No

### REFLUX:
- Yes
- No

### NAUSEA:
- Yes
- No

### APPETITE:
- Normal
- Decreased

### VOMITING:
- Yes
- No

### BOWELS:
- Normal
- Constipated
- Diarrhea

## PAST HISTORY:

### PREVIOUS CHEST PAIN:
- Yes
- No

### SMOKER:
- Yes
- No

### PREVIOUS C-R ILLNESS:
- Yes
- No

### POSITIVE Hx:
- MI
- Angina

### HISTORY MAJOR SURGERY:
- Yes
- No

### Bronchitis
- Hypertension
- Diabetes
- None

## DURATION OF PAIN:
(How long has the pt had the pain?)
- ________ Hours

## TYPE OF PAIN
- Tight
- Gripping
- Dull
- Sharp
- Burning
- Stabbing
- Hvy/Press/Crush
- Aching
- Nagging

## SEVERITY OF PAIN
(do not ask if obvious distress = severe
everything else = moderate)
- Moderate
- Severe

## AGGRAVATING FACTORS
- Movement
- Cough
- Breathing
- Sitting
- Lying Down/Rest
- Leaning Forward
- Other
- None

## NUMBNESS:
- Yes
- No

## ONSET OF PAIN:
- Sudden
- Gradual

## TIME COURSE OF PAIN:
(at times free of pain = intermittent,
everything else = continuous)
- Continuous
- Intermittent

## PROGRESS OF PAIN:
- Better
- Same
- Worse

## RELIEVING FACTORS:
- Nitro
- Rest
- Walking
- Morphine
- Other Drugs
- Other
- None
# Physical Exam

**VITAL SIGNS**
- **Temperature**
- **Pulse Rate**
- **Respiration**

**Blood Pressure**
- **Systolic**: _______
- **Diastolic**: _______

**Examination**
- **Edema**: Absent, Ankies, Other
- **Percussion**:
  - Normal, Abnormal
- **Sweating**:
  - (not due to environ. or exercise)
  - Yes, No
- **Hyper-Resonant**, **Dull**
- **Shivering**:
  - (not due to environ. or exercise)
  - Yes, No
- **Rhonchi**, **Decreased**
- **Cold/Clammy**:
  - Yes, No
- **Jugular Venous Press.**:
  - (pt. reclined at 45 deg., chin at 30 deg., to left minuscus more than 1/2 dist to clavical = raised, otherwise = normal)
- **Tenderness Calves**:
  - Yes, Normal, Raised, Lowered
- **Heart Sounds**:
  - (If 1st & 2nd sounds = lub-dub then normal, other = abnormal)
- **Tenderness Chest**:
  - Yes, Normal, Abnormal

**Lab Results**
- **EEG Results**:
  - ST Elevation
  - T Depression
  - Q Waves
  - ST Depression
  - Arrhythmia
  - No Apparent Distress
- **SGOT**: _______

**General Exam**
- **Mood**:
  - (obvious distress or physical symptoms = distress, concern about illness = anxious)
  - Normal, Anxious
  - Distressed, In Shock
- **Color**:
  - (consider temp., check palms & conjunctiva on black or oriental)
  - Normal, Pale
  - Flushed, Cyanotic

**Physical Exam**

**Corpman's Diagnosis**: MI ANGINA Non-Specific Chest Pain CHEST INFECTION OTHER: _______

**Medical Officer's Diagnosis**: MI ANGINA Non-Specific Chest Pain CHEST INFECTION OTHER: _______

**MEDEVAC**: Yes No
Appendix B: Text Editor Commands
### Cursor Movements

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Arrow</td>
<td>Move one character to the right</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Move one character to the left</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Move up on line</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Move down one line</td>
</tr>
<tr>
<td>Home</td>
<td>Move to the end of the line</td>
</tr>
<tr>
<td>End</td>
<td>Move up one window-full of text</td>
</tr>
<tr>
<td>PgUp</td>
<td>Move down one window-full of text</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Move one word right</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Move one word left</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>Move to the beginning of text</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Move to the end of text</td>
</tr>
</tbody>
</table>

### Select text with keyboard

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Arrow Keys</td>
<td>Select a range of characters</td>
</tr>
<tr>
<td>shift Arrow Keys</td>
<td>Select a range of words</td>
</tr>
<tr>
<td>Shift + Ctrl Arrow Keys</td>
<td>Select from cursor to beginning of text</td>
</tr>
<tr>
<td>Shift + Ctrl + End</td>
<td>Select from cursor to end of text</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select entire document</td>
</tr>
<tr>
<td>Select text with Mouse</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Drag</td>
<td>Select a range of characters</td>
</tr>
<tr>
<td>Double-click</td>
<td>Select a range of words</td>
</tr>
<tr>
<td>Double-click and drag</td>
<td>Select from cursor to beginning of text</td>
</tr>
<tr>
<td>drag Keys</td>
<td></td>
</tr>
<tr>
<td>Triple-click</td>
<td>Select from cursor to end of text</td>
</tr>
<tr>
<td>Triple-click and drag</td>
<td>Select entire document</td>
</tr>
<tr>
<td>Delete and Replace</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Place cursor to the right of the character, press</td>
<td>Delete a characters</td>
</tr>
<tr>
<td>Backspace, or place cursor at the character, press</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Place cursor anywhere in word, press</td>
<td>Delete a words</td>
</tr>
<tr>
<td>Ctrl+Backspace</td>
<td></td>
</tr>
<tr>
<td>Select and press Backspace</td>
<td>Delete a selection</td>
</tr>
<tr>
<td>Select text to be replaced, type new text (or Paste)</td>
<td>Replace existing text</td>
</tr>
<tr>
<td>Cut, Copy and Paste</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Select the text, press Ctrl+X or use Cut in the Edit menu</strong></td>
<td>Cut Text</td>
</tr>
<tr>
<td><strong>Select the text, press Ctrl+C or use Copy in the Edit menu</strong></td>
<td>Copy Text</td>
</tr>
<tr>
<td><strong>Press Ctrl+V or use Paste in the Edit menu</strong></td>
<td>Delete a selection</td>
</tr>
<tr>
<td><strong>Select text, press Ctrl+V or use Paste in the Edit menu</strong></td>
<td>Replace existing text</td>
</tr>
</tbody>
</table>
Appendix C: Diary/Calendar Commands
**Diary/Calendar Commands.** At the bottom of the Calendar/Diary window are push buttons used to change the calendar. These buttons correspond to first five options on the Diary menu popup.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
<th>Diary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Back Month PgUp</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ahead Month PgUp</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Back Year Shift+PgUp</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ahead Year shift+PgDn</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Today T</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Diary Tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Calendar shift+Tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Delete...</td>
</tr>
</tbody>
</table>

**Calendar Panel.** The Calendar panel appears with the current month displayed and the current day’s date selected. The month and year at the top of the calendar are highlighted when the Calendar panel is active.

To change the selected date, use the arrow keys or click on the desired day. To change the month backward or forward, use the PgUp and PgDn keys or the two month push buttons, ← M and M →, at the bottom of the window. To change the calendar backward and forward by year, use shift+PgUp and Shift+PgDn or the year push buttons, ← Y and Y →, at the bottom of the window.

To select today’s date by pressing T on the keyboard or by choosing the TODAY push button. This is quick way to get back to the current day.

**Diary Panel.** The *Diary Menu* popup contains options corresponding to those of the Calendar Panel. There can be a diary entry for each day. To make a diary entry select the day in the Calendar panel. Active the Diary panel by pressing Tab or clicking on the panel with the mouse. The cursor flashes in the Diary panel, indicating that it is active.

The diary panel is a text region so the user can use standard text editing techniques. There is no limit to the amount of text that can be enter. All dates that have a diary entry are displayed as enhanced text.
Delete Entries. Each diary entry is stored in the file until deleted by the user. The user refers to these entries by selecting a date. These entries should be cleared from time to time to keep from wasting disk space.

Diary entries are deleted backwards from a selected date. To delete the entry, select a day on the calendar and choose Delete... from the Diary Menu popup. All text entries prior to but not including that day will be erased. An alert appears to confirm the action. Choose Yes to delete the entries. No will return the Calendar/Diary option without deleting any entries.

Delete all diary entries prior to 01/01/92?
< Yes >  « No »
Appendix D: Installation Guide

This Appendix contains the listings of the four files used in the installation of the CAMD system; CAMDREAD.DOC, INSTALL.BAT, INSTALL.TXT and CAMD.BAT. The CAMDREAD.DOC contains the instructions for installing the CAMD system. The INSTALL.BAT is the batch file that installs the CAMD system from the three floppy disks to the hard drive. The INSTALL.TXT contains the messages that are displayed during installation. The CAMD.BAT is the batch file that starts the CAMD system once it has been installed.
The CAMD system needs 3 Mega bytes on a hard drive. This installation package includes three 5 1/4" low density floppy disks.

To install the CAMD system, complete the following:

1. Put the CAMD INSTALLATION DISK #1 into disk drive (A or B)

2. Goto floppy disk drive. Type A: or B:

3. Type> INSTALL A: C: (A: the source drive (floppy), C: the destination drive). This will start the installation batch file (INSTALL.BAT).

4. The installation will display a message requesting the next disk. Put in disk #2 in floppy drive and press ENTER. This process will be continued for disk #3. After disk #3 is done, Put disk #1 back into the source drive.

5. In the root directory (C:\) modify or add the FILES and SHELL commands in the CONFIG.SYS file. The FILES command should be set to 50 or more (FILES=50). The SHELL command should read (SHELL=COMMAND.COM /P /E:512) for DOS 3.2 and higher and (SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and below.

6. Reboot the computer.

7. At the DOS prompt type C:\CAMD>CAMD to start (execute) the CAMD system. This will start the CAMD.BAT file.

8. The password is CAMD.
INSTALL.BAT

echo off
:install.bat hll@nhrc
if "%2"=="" goto L1
cls
type install.txt
pause
cls
md %2\camd
cd %2\camd
copy splice.com %2
splice %1\camdata.exe
camdata.exe -d
splice %1\camdsrc.exe
camdsrc.exe -d
del camdata.exe
del camdsrc.exe
del splice.com
cls
echo Remove Disk from Drive
echo CAMD installation completed!!!
echo

echo Note: Go to root directory, modify or add the FILES and SHELL
echo commands into CONFIG.SYS file, the FILES command should be set to 50
echo or more (FILES=50). The SHELL command should read
echo (SHELL=COMMAND.COM /P /E:512) for DOS 3.2 and higher and
echo (SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and below.
echo Reboot the system.
echo
goto end
:L1
echo format: INSTALL s: d:
echo s: source drive (a: or b:)
echo d: destination drive (c: or d:) to install the camd system.
:END
INSTALL.TXT

This will install the Computer Assisted Medical Diagnostic System.

This installation will create a subdirectories \CAMD on your destination drive. You will need a minimum of approximately 3 MB of space available for all the necessary files. In the root directory (C:\) modify or add the FILES and SHELL commands to the CONFIG.SYS file. The FILES command should be set to 50 or more (FILES=50). The SHELL command should read (SHELL=COMMAND.COM /P /E:512) for DOS 3.2 and higher and (SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and below.

If the \CAMD subdirectory is not on the same drive as the \SNAP subdirectory, modify the CAMD.BAT to set the appropriate drive and path in the system environment.

If you want to discontinue the installation, hit Ctrl-C.

If you have any questions regarding the installation, call:

D.M. Pearsall (Dee)
Naval Health Research Center
P.O.Box 85122, San Diego, CA 92186-5122
DSN or Commercial 553-8401 Area Code (619)
CAML.BAT

echo off
:
This runs the CAMD demo from MS-DOS and
:establishes path and environment variables
:This camd.bat not hard code SAMS environment to specific drive. It assume
:was CAMD system has same drive with SAMS.
IF not "%camd%" == "" goto L05
:this is the data path
set camd=\camd\data
L05
IF not "%sams%" == "" goto L1
:this is the sams system path
set sams=\snap\sams
L1
IF not "%camdx%" == "" goto L2
set camdx=\camd\bin
L2
if not exist %camd%\system.dbf goto usage
if exist %camdx%\camd.exe goto camdex
goto end
:camdex
:run DOS executable
cd %camdx%
camd
goto end
:usage
echo File not found %camd%\system.dbf
echo You must be on disk with %camd% directory
:end
cd..
The CAMD system is designed to assist corpsmen in rendering a medical diagnosis. The CAMD system was written in FoxPro Version 2.0, a database management system. The signs, symptoms, and laboratory information collected by the Abdominal and Chest modules can be gathered on the standard forms developed for CAMD, or entered directly (real time) into the system. The Chronological Record of Medical Care Standard Form 600 (SF600) can then be generated and edited to document an encounter. Additional, information from the disease and treatment files can be added to the SF600. The CAMD system User’s Guide was written to introduce the Independent Duty Corpsmen to this software system, explaining the Keyboard and Mouse commands necessary to run the various options, and displaying the screens associated with them.